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Setting up folders on your external hard drive

This lesson will show you how to set up your folders on an external hard drive.

Select your External HD

—‘

External_HD

Find your external HD on your Desktop

Make first new folder

eno o _ External_HD

@.’:1’]1 "- = | 0D | Il E] o
Open

i Open With N g >

Move to Trash

Get Info

1. Press the Action Button
2. Select New Folder

Your catalogue and Images folder

® 00 __ External_HD
EARE-AREILS BH=om(=-(=2] (=]
Action Dropbox Back View Arrange Share Path

Creative Cloud Files

SHARED
(=) epson987f05

Geoff_Catalog
DEVICES

L Geoff White's Co...
42 timemachine_2 =

|- Geoff Mac

Make a new folder and name it: YourName_Catalog
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Folder

(3] 0.0 __ External_HD
() (@) («i»] El=om(=-])(=2](=-] (8]
Action Dropbox Back View Arrange Share Path Connect

@ Creative Cloud Files

SHARED
(5 epson987f05 Geoff Catalog
DEVICES

Select the new folder, then select Get Info. Note this may be located differently on some
systems.

Label

©® O O [] Geoff_Catalog Info

i Geoff_Catalog Zero KB
Modified: Today 17:44

¥ Spotlight Comments:

¥ Ceneral:

Kind: Folder
Size: Zero bytes (Zero byts »©n disk)

for 1 item
Where: /Volumes/Ext
Created: Today 17
Modified: Today 17*
Label: x

[ | Shared folder
[ | Locked

Now select the RED label. This will make the folder more visible in the Finder.

Red Label
® 00 | External_HD
(&) (&) (») B=om (a](2](=]
Action Dropbox Back View Arrange Share Path
@2 Creative Cloud Files -
SHARED
[E) epson987f05 Geoff Catal

Now enter the new folder.
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Download Folder

In the YourName_Catalog folder, make a new folder and title it: Download_Folder.

(3] 0.0 (1] Geoff_Catalog
(-] (8] [(«>] Bl=som (=] (2] (=
Action Dropbox Back View Arrange Share Path

& Creative Cloud Files

SHARED
[ epson987f05
DEVICES Download_Folder

L] Geoff White's Co...

Working Folder

e 00 (1 Geoff_Catalog
(-] (8] («>] mm| (=] (2] [=]

Action Dropbox Back ew Arrange Share Path

<[l

«2 Creative Cloud Files

SHARED
[ epson987f05

——

DEVICES Download_Folder

] Geoff White's Co...

Now make a second new folder, and name it: Working_Folder.

Folder Structure

® 0o

[ Geoff_Catalog

EXREREI

lls -l e L=l B Lol 6 o]

Action Dropbox Back

Arrange Share Path Connect Get Info Quick Look

@ Creative Cloud Files
SHARED

(5 epson987f05
DEVICES

L1 Geoff White's Co...

|9 timemachine 2 4

|-l Geoff Mac

»

M Geoff_Catalog [ ] (] Download_Folder "
(L] Working_Folder "

Q External_HD —

Change the folder view to Column View, your folder structure should look as illustrated.
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Make new catalog

This lesson will show you how to make a new catalog and where to save it

Opening Lightroom from the Dock

Adobe Photg

aqp Lightroom 4

Hold down the OPT (Alt) Key then select Lightroom icon from the Dock (at the bottom of the
screen)

Opening Lightroom from the Applications Folder

®e0o (2] Applications

MRS = | 00 | i @ m
L) EE[o)w] (=]
Action Dropbox Back View Path Connect iDisk
1= Geoff White's Computer

iDisk

« LaCie 250 Gb

" (3)
| NIKON D705 b
PLACES I r
£2 Dropbox
E Desktop

&Y Geoff
= Documents e Adobe Photoshop CS6 Adobe Photoshop
Lightroom 4.app

»

»

/- Applications

=
=8 Movies

e L
(@i Pictures \_O) - /
ﬂ Music e v
f@or g g N
€ sites )") N‘J

SEARCH FOR

Open the Finder,

1. Choose the file view that suits you best
2. Navigate to the Applications.
3. Hold down the OPT (Alt) Key then double click Lightroom icon.
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New Catalog

Adobe Photoshop Lightroom - Select Catalog

Select a recent catalog to open

'ﬁ imacon.Ircat /Users/Geoff/Desktop/Scratchpad/imacon
P video.Ircat JUsers [Geoff/Desktop/niamh/Video Project/video
() Always load this catalog on startup () Test integrity of this catalog

Note: Lightroom Catalogs cannot be on network volumes or in read-only folders.

Choose a Different Catalog... /’_\ ( ) ( )

) [ Create a New Catalog... ) Quit ) Open

Since this is your first Lr catalog, it will give you the opportunity of making a new catalog, select
Create a New Catalog

Enter catalog location and name

OO, Create Folder with New Catalog

g Save/As: Geoffs_catalog| ]B

< » ) (23 }=J m) [ [ EXTERNAL_HD M Q@

= Geoff's .. (1] Download_Folder Today, 11:10
B Geoff ... (L1 Working_Folder 18/06/2011

s

——
PLACES
A Desktop N

£ Geoff

:‘_] Documents
V}§ Applicati...
E Movies

(@ Pictures
53 Music 0
@ or -
€ sites £

v

(_ New Folder ) ( Cancel ) ( Create ) J
— — 4

DEVICES I Name: 4| Date Modified

1. Navigate to the external HD where yur other Folders are located.
2. Enter a name for your catalog.
3. when finished, select Create

Lightroom v5 - 9



Lightroom opens

& Light Edit_Library _Photo _ Metadata _View _Window _Help

13 @ £ O 2 M o GCaged ¢ [ Wed 1136 Q

The Lrinterface will now open. Since it has not yet been populated with images it will be
largely blank.

The Finder

‘800 |_| EXTERNAL_HD

=
(3#-](«[-]) E=s[om] (=] (7] »
DEVICES
) Geoff's Mac 3
L — . (R—
PLACES Download_Folder  Working_Folder Geoffs_catalog
E Desktop
Q Geoff

[} Documents

7&3 Applications

E Movies

(@} Pictures "

ﬂ Music M

3 items, 39.73 GB available e m—

Now open the Finder, you will see a new folder which contains your new catalog fo;der.

Catalog folder contents

T — TR aws 2, =

iz
®no [:J Geoff. catalog
(-] (8] [<[>] = @ £ 0 (o a
Action Dropbox Back é Path é Connect iDlsk Get Info Quick Look

D _EV]CES [oun N o N N B

| Geoff's Mac .::

& Geoff White's Computer - (B

£ ipisk Geoff_catalog Geoff_catalog.lica Geoff_catalog.Irca Geoff_catalog.Irca Lightroom

« LaCie 250 Gb — Previews.Irdata t t-journal t.lock Settings

NIKON D705 a e
=)
- L) (2) ©

1. These two files are your catalog files. They will contain information about your images
(Metadata) but not the images themselves.

2. These two files are temporary files which are created when Lris opened and deleted again
when it closes.

3. The Lightroom Settings Folder containts your presets and preferences.

Lightroom v5 - 10



Setting preferences

In this lesson you will set your Lightroom 4 preferences.

Open Preferences

m File Edit Develop Photo Setti

M O About Adobe Photoshop Lightroom 4.1...

Preferences... N
Catalog Settings...
Identity Plate Setup...
Edit Watermarks...

Services

Hide Lightroom
Hide Others

Quit Lightroom

Go Lightroom > Preferences

General references

NN Preferences

— [ General | Fresets External Editing File Handling Interface |

Language: | English ﬂ

Settings: @ Show splash screen during startup

M Automatically check for updates

Default Catalog

o When starting up use this catalog: = Load most recent catalog
e

Import Options
") Show import dialog when a memory card is detected

@ Ignore camera-generated folder names when naming folders

(- 2]

[] Treat JPEG files next to raw files as separate photos

Select General

Tick both Settings boxes.

Under Default Catalog, select Load default catalog.
Do not tick box: Show import dialogue . ...

Tick box: Ignore camera-generated folder, , ,, .

abkonN =
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Presets Preferences

h N
(&) @ Preferences

General | Presets | External Editing File Handling Interface |

Default Develop Settings
° [T Apply auto tone adjustments
Pply 1)
M Apply auto mix when first converting to black and white
") Make defaults specific to camera serial number

7] Make defaults specific to camera ISO setting

{_Reset all default Develop settings )

o

Location

[2] Store presets with catalog ( Show Lightroom Presets Folder... )

1. Select: "Presets.
2. Tick boxes as shown.
3. Tick box: Store presets with catalog.

Export Editing Preferences

(TN 10‘ Preferences
i

Ceneral  Presets | External Editing | File Handling Interface )

01 Edit in Adobe Photoshop CS6
-

: . L. The AdobeRGB (1938) color space cannot encompass the full range
PSP - of colors available within Lightroom. PSD can be less efficient than
- TIFF with respect to metadata updates. When saving from Photoshop,
Color Space: | AdobeRGB (1998) v please be sure to use the “Maximize Compatibility” option in
Photoshop. Failure to do so will result in images that cannot be read

Bit Depth: | 16 bits/component ?] by Lightroom.

Resolution: 240

1. Select: Export editing Preferences.
2. Enter settings for Edit in Adobe Photoshop CS6 as shown.

File Handling Preferences

®N0O Prefergies
0

)|

General Presets External Editing | File Handling | Interface

Import DNG Creation

File Extension: | dng a

Compatibility: | Camera Raw 7.1 and later %

JPEG Preview: | Medium Size 9

[ﬂ Embed Fast Load Data o

= -4
[} Embed Original Raw File °
-

000

1. Select: File Handling.
2. Choose: dng (lowercase).
3. Choose: Camera Raw 7,1 or later (this will be compatible with Photoshop CS6 and later).

Lightroom v5 - 12



Use Camera Raw 6.6 or later for compatibility with Photoshop CS5.
4. Choose: Medium Size.
Tick box: Load fast load s=data.
6. Do nottick box: Embed Original Raw File

o

Close Preferences

NorNe Preferences

—
)|

< [ General = Presets External Editing | File Handling | Interface

A
%ﬂ NNC Creatinn

Click on red to close Preferences.
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Setting your IPTC Identity

In this lesson you will learn how to set your IPTC identity data. This metadata should be
automatically embedded in all imported and exported image files. The metadata will clearly
state the file's owner's name and contact details

Edit Metadata Presets ..

Photo MYEEGEIZE View Window Help
Set Keyword Shortcut... 43K

Toggle Shortcut Keyword K
Enable Painting

Library F

Keyword Set
Color Label Set

Show Metadata for Target Photo Only

Copy Metadata...

Paste Metadata {8V

Sync Metadata...
Enable Auto Sync

Edit Metadata Presets...

Go Metadata > Edit Metadata Presets ...
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Metadata Presets Panel

Preset: | Custom

=1

Rights Usage Terms |

O ad

Copyright Info URL _

A4 g IPTC Creator

Creator |

Creator Address |

Creator City

Creator State / Province

Creator Postal Code

Creator Country

Creator Phone |

Creator E-Mail .

Creator Website |

(EEAAEEEEE

Creator Job Title |

¥ I IPTC Image
Date Created |

Intellectual Genre |
IPTC Scene Code |

Sublocation |
City |
State / Province

Country |
ISO Country Code

00000000

alr(

[ﬂ

( Check Al ) ( Check None ) ( Check Filled )

N

Scroll down the panel to view the IPTC Creator panel.
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Complete the form

LONOO Edit Metadata Presets

&3

Preset: L Geoffs DITa\tity

v # IPTC Creator

_—

©

Creator Geoff White ~

Creator Address 31 East Essex Street

Creator City Dublin

N\
N
Creator State / Province \ e
4 S
V4
Z
£

Creator Postal Code D2

Creator Country Ireland

Creator Phone = 353 (0)1 6752613

REREAARREEEE®

Creator E-Mail [geoff.white@dit.ie|

Creator Website www.dit.ie /

Creator Job Title Photographer

1. Make sure thatthe box is ticked.
2. Unless the boxes below are ticked, then the corresponding data will not be saved.
3. Now fill in your personal details as appropriate.

Remember, this information will be attached to all yourimages. Do not use data which is likely
to be short term or temporary.
This data can be changed and updated at a later time if necessary.

Save the New preset

LOLOO Edit Metadata Presets

Prese v Custom g

——  Aine Default ’
M Geoff @ DIT Defaults
Geoff IPTC
Roisin Metadata
Sponge Default

&

Save Current Settings as New Preset...

Creator Postal Code D2 [

Creator Country Ireland

Creator Phone = 353 (0)1 6752613

Creator E-Mail geoff.white2dit.ie

Creator Website www.dit.ie

AEEAEEE

Creator Job Title Photographer

Go Preset > Save Current Preset as New Preset ...
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Name it

LOLOO New Preset

Preset Name: [Ceoffs DIT identity{

( Cancel ) ( Create

-

1. Give the Preseta name.
2. SelectCreate.

Complete this step

IPTC Scene Code

Sublocation A
(" check All ) ( Check None ) ( Check Filled )
\——//2

Complete the process by selecting Done.
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Setting your Copyright

In this lesson you will set yourself as the copyright owner of the material that you produce. This
metadata should be automatically embedded in all imported and exported image files.

IPTC Copyright

N.O)LO ko‘ Edit Metadata Presets
D4

ereset: | Geoffs DIT identity (edited) 14
4

= =] IPTC Copyright
_ Copyright [Geof‘f White| ]

‘\/ -
o Copyright Statu¢ v Unknown
.g Rights Usage Copyrlghted

Public Domain -

| @ &
10

| (O

Copyright Info URL,

(

v @ IPTC Creator

&

Creator Geoff White

Open Edit Presets again

Scroll down to IPTC Copyright.

Ensure that the first two boxes are both ticked.
Enter your full name.

From the drop down menu, select Copyrighted.

abkownN=

Save changes

of‘ O Edit Metadata Presets
S

Prese v Geoffs DIT identity (edited) B

Aine Default

v (5 Geoff @ DIT Defaults
Geoff IPTC
GCeoffs DIT identity
Roisin Metadata
Sponge Default

Save Current Settings as New Preset...
Update Preset “Geoffs DIT identity”

Creator Geoff White | g n

©

1. Go Presets.
2. SelectUpdate Preset "Your Name"
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Complete this step

IPTC Scene Code

Sublocation

( Check All ) (Check None ) (Check Filled )

Complete the process by selecting Done.
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Making your Identity Plate

In this lesson you will make a Name Plate to disply on the top let of the Lightroom interface

Preferences

o TNl File Edit Library Photo M
About Adobe Photoshop Lightroom 3...

Preferences... 38,
Catalog Settings... X &,
Identity Plate Setup...
Edit Watermarks...

Go to Preferences > Identity Name Plate ...

Enter name
e Identity Plate Editor
le Enable Identity Plate | Custom ﬂ ADUBE
Personalize the Lightroom environment with your own branding elements.
°;e a styled text identity plate () Use a graphical identity plate ...and choose a complementary typeface for the module picker buttons.
Lightroom Library | Develop | Slideshow
Myriad Web Pro %) [ Regular IBREERE Myriad Web Pro %) [ Regular ¥ 22 ¥ [Om
("Hide De(ag g (" cCancel )
1. Selectthe current name plate. Type in your name in its place.
2. Change the typeface if you wish.
3. Adjustthe weitght and size if you also
Save as ...
.0 Identity Plate Editor
@ Enable Identity Plat¢ v Custom a ADUBE
Personalize the Lightroom Geoff name plate lements. e
EET

...and choose a complementary typeface for the module picker buttons.

GeOffWhite’ Library | Develop | Slideshow

| Myriad Web Pro _3] Regular ﬂ 36 3 O | Myriad Web Pro ﬂ | Regular ﬂ 22 E]

]|

‘ Hide Details )

(" Cancel ) 0K

Using the drop down menu, Save as ...

Lightroom v5 - 20



Name the identity plate!

Give your name plate a name. Save.

New identity plate

® Lightroom File Edit Library Photo M

Geoff White

» Navigator Library Filte

Your identity plate will now be visible.
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Importing Raw Files
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Transfering files to Download folder

In this lesson you will transfer your RAW files from your camera's memory card to your

Download_Folder

Card reader

Ensure that your card reader is visible in the Finder.

Navigate to your RAW files.

Download Folder

eno (] Download_Folder (@)
(=] (i ] a
DEVICES Name 4| Date Modified Size Kind
=} Geoff's Mac = DSC_0001.nef 21 Apr 2007 14:14 6 MB Nikon Ele...ormat file
| EXTERN... & = DSC_0002.nef 21 Apr 2007 14:14 5.8 MB Nikon Ele...ormat file m
o & DSC_0003.nef 21 Apr 2007 14:15 6.2 MB Nikon Ele...ormat file
PLACES = DSC_0004.nef 21 Apr 2007 14:15 6.1MB  Nikon Ele...ormat file
E Baskion m DSC_0005.nef 21 Apr 2007 14:16 6MB  Nikon Ele...ormat file
Q = B DSC_0006.nef 21 Apr 2007 14:16 5.5MB Nikon Ele...ormat file
A B DSC_0007.nef 21 Apr 2007 14:16 S.8MB  Nikon Ele...ormat file
7\ Applications = DSC_0008.nef 21 Apr 2007 14:16 6MB  Nikon Ele...ormat file
E Movies = DSC_0009.nef 21 Apr 2007 14:25 5.6 MB Nikon Ele...ormat file
(@ Pictures 3 = DSC_0010.nef 21 Apr 2007 14:26 5.8 MB Nikon Ele...ormat file 3
ﬁ Music v = DSC_0011.nef 21 Apr 2007 14:26 5.8 MB Nikon Ele...ormat file v
39 items, 39.73 GB available 4
Open the Download_Folder
Download_Folder
%~ <"~ SSE’HD‘MIH = o Lod Q
DEVICES Name 4 Date Modified Size Kind
=4 Geoff's Mac = DSC_0001.nef 21 Apr 2007 14:14 6 MB Nikon Ele...ormat file 1
EXTERN... & = DSC_0002.nef 21 Apr 2007 14:14 5.8 MB Nikon Ele...ormat file
& DSC_0003.nef 21 Apr 2007 14:15 6.2 MB Nikon Ele...ormat file
PLACES
A Deskeop Working_Folder
@ Geoff | (38~ « > B o m (= o ol
"jl Docume — N
1A! Applicat ¥ DEVICES Name Date Modified Size
B Movies ) Geoff's Mac
£@ Pictures| = EXTERN.. =
J3 Music PLACES
. A pesktop
ﬁ‘ Q Geoff

7 Documents
/A Applications

E Movies

(@l Pictures

J3 Music

0 items, 39.73 GB available

Kind

1. Press CMD + N, to Open an New Finder Window

2. Inthe new window, navigate to the Working_Folder.
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Select RAW files to transfer

800 []1101ND70S (e}
(«]>] o] (=] O Q ‘
¥ DEVICES ~ Name Date Modified Size Kind
=) Geoff's Mac = DSC_6021.NEF 22 May 2011 14:23 S.9MB  Nikon ...at file
| NIKON D705 a = DSC_6022.NEF 22 May 2011 14:23 S.8MB  Nikon ...at file
| EXTERNAL_HD a = DSC_6023.NEF 22 May 2011 14:23 S.7MB  Nikon ...at file
= DSC_6024.NEF 22 May 2011 14:37 5.9MB  Nikon ...at file
ok 1 DSC_6025.NEF 22 May 2011 14:37 5.9MB__ Nikon ...at file
¥ PLACES ) DSC_6026.NEF 22 May 2011 14:37 6MB__ Nikon ...at file
A Desktop O DSC_6027.NEF 22 May 2011 14:37 5.9MB___ Nikon ...at file
@ Geoff ) DSC_6028.NEF 22 May 2011 14:37 5.9MB  Nikon ...at file
[ Documents = DSC_6029.NEF 22 May 2011 14:38 S.9MB  Nikon ...at file
A Applications = DSC_6030.NEF 22 May 2011 14:38 6.1MB  Nikon ..atfile
B} Movies = DSC_6031.NEF 22 May 2011 14:38 6.1 MB Nikon ...at file
&2 Pictures = DSC_6032.NEF 22 May 2011 14:38 5.7MB  Nikon ...at file m
7 Music m DSC_6033.NEF 22 May 2011 14:38 S.9MB  Nikon ...at file
e = DSC_6034.NEF 22 May 2011 14:38 S.OMB  Nikon ...at file
@ ses . = DSC_6035.NEF 22 May 2011 14:39 S.8MB  Nikon ...at file e
v = DSC_6036.NEF 22 May 2011 14:39 S.8MB  Nikon ...at file

To select ALL image files: CMD + A

To select a range of files: Select the first file, then Shift + Select the lastfile in the range, as

illustrated.

4 of 156 selected, 14.9 MB available

To select a remove a file rom a selection: CMD + Select

Drag and Drop

(] Download_Folder

EXMIRIE LB mm (= o o Q
¥ DEVICES Name 4 Date Modified Siz
) Geoff's Mac
|| NIKON D705 &
|_ EXTERNAL.. &
» SHARED
¥ PLACES
(1101IND70S (@]
— ==
0 a
- dame Date Modified Size Kind
= DSC_6021.NEF 22 May 2011 14:23 5.9 MB Nikon ...at file
DSC_6022.NEF 22 May 2011 14:23 5.8 MB Nikon ...at file
= DSC_6023.NEF 22 May 2011 14:23 5.7 MB Nikon ...at file
= DSC_6024.NEF 22 May 2011 14:37 5.9 MB Nikon ...at file
O DSC_6025.NEF 22 May 2011 14:37 5.9 MB Nikon ...at file
O DSC_6026.NEF 22 May 2011 14:37 6 MB Nikon ...at file
O DSC_6027.NEF 22 May 2011 14:37 5.9 MB Nikon ...at file
= DSC_6028.NEF 22 May 2011 14:37 5.9 MB Nikon ...at file
= DSC_6029.NEF 22 May 2011 14:38 5.9 MB Nikon ...at file
= DSC_6030.NEF 22 May 2011 14:38 6.1 MB Nikon ...at file
= DSC_6031.NEF 22 May 2011 14:38 6.1 MB Nikon ...at file

Ensure that both folders are open and visible.
Now drag your select RAW files to the Download_Folder and drop.
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Setting up File Naming template

Before importing for the first time you need to set up the File Naming template. This will apply
the correct file naming convention to all imported image files.

All files should follow the format: yourname_YYYYMMDD_0001. Once this template is setup,
it must be used for all file imports as part of the import procedure..

Import Photos . . .

Edit Library Photo Metadata Viev

New Catalogsm.
Open Catalog... g ¢ #0

Open Recent

Optimize Catalog...

-

Import Photos...
Import from Catalog...
Tethered Capture B
Auto Import

1. Go File > Import Photos ...
2. Oir, press the Import ,,,, button (bottom left).

File Renaming

R Geoff's Mac

v' Rename Files

Template = Shoot Name - Or...

Open the File Naming panel on the righthand side.
Select Template.
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Edit template

Geoff Preset - Scanned Images
Roisin Preset
¥ Shoot Name - Original File Number
Shoot Name - Sequence
Sufix demo

Extensions = Lowercase

Select Edit ...

Template Editor

Filename Template Editor

Preset: L Shoot Name - Original File Number (edited) v

Example: gewhite_.dng

gewhi te_]

Image Name

1. Clear the text box,

2. Enter your name using lowercase in the form: two initials followed by family name. Do not
use any spaces or punctuation marks.

3. Now enter an Underscore. Note example above the text box.

Add date information

| Sequence # (0001) %) (insert )
Additional
vdle (vionun vuw, 11Ty
o  ate ooy | D
Date (YYMMDN)
Date (YYYY) 9 \Ins_ert)\/
Date (YY)
Custom | pate (Month) r
Date (Mon) Beinsert=
Date (MM)
Date (DD) (_Insert )
Julian Day of the Year
Hour
Minute cel ) ( Done )
Second

1. Select from the drop down menu: Date (YYYYMMDD).
2. SelectlInsert.
3. Enter another Underscore.
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Add the File Number

Filename Template Editor

Preset: | Custom Name - Original File Number (edited)

-+

Example: gewhite_20120927_.dng

1. Select: File Name Suffix
2. SelectlInsert.

gewhite_

Date (YYYYMMDD)

Image Nam

Filename

. . | )
v Filename number suffix s Insert

Save the preset

Filename Template Editor

0 Prese

Exampli
=

gewhite,

S

Image Ni

Numberi

Addition

<" Shoot Name - Original File Number (edited)

Add "_HDR"

Aine Presets

Custom Name (x of y)

Custom Name - Original File Number
Custom Name - Sequence

Custom Name

Date - Filename

Filename - Sequence

Filename

Geoff Mobile Phone

Geoff Basic Preset

Ceoff Preset - Scanned Images
Roisin Preset

Session Name - Sequence

Shoot Name - Original File Number
Shoot Name - Seguence

Sufix demo

A4l save Current Settings as NewPreset... | 0 |

Upddie Fresel SrouL Narme = urniginai rile Number™

1. Open the Preset drop down menu.
2. Select Save Current Settings as New Preset ....
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Name the preset

LOLOLO New Preset

Preset Name: | Geoff' default plreset Q }

(" Cancel ) € CreateSO/

1. Enter your name fo the Preset Name.
2. SelectCreate.

Complete it

(" Cancel ) ( Done )

Select Done.
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Importing - source and destination

In this lesson you will set the source and destinations for your files, plus conversion from
camrea manufacturer's Raw files to DNG Raw files.

Import Photos . . .

Edit Library Photo Metadata Viev

New Catalog:::
Open Catalog... 9 €380
Open Recent

Optimize Catalog...

-

Import Photos...
Import from Catalog...
Tethered Capture B
Auto Import

Go File > Import Photos ...
Or, press the Import ,,,, button (bottom left).

Source

! G EXTERNAL HD :

20uUrce

Files Include Subfolders v" All Photos

Geoff's Mac
v Users

> @l Geoff
» @A Shared

EXTERNAL_HD

) Download_Folder

@8 Geoffs_catalog
@8 Working_Folder

Select the source folder, Download_Folder, on your external HD.
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Destination

39 photos

Into Subfolder

Organize | Into one folder
Geoff's Mac

EXTERNAL_HD

@8 Download_Folder
@ Geoffs_catalog

| > [ Working_Folder

Select the destination folder, Working_Folder, on your external HD.

Convert RAW files to DNG (Digital Negative Raw files)

Copy as DNG

All Photos New Photos Destination Folders

Select, Copy as DNG.
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Selecting files to Import

@ DSC_0037.nef @ DSC_0038.nef DSC_0039.nef
Check A Uncheck All

1. Ensure that you are in Grid View.
2. Select Check All to select all images to be imported.
3. Individual images can be selected, or de-selected, by usinf the tick boxes.

File Handling

E ‘,_1

Build Smart Previews @

@ on't Import Suspected Duplicates

Make a Second Copy To :

Select: Render Previews > Standard.

Leave unselected the tick box: Build Smart Previews

Tick box: Don't Import Suspected Duplicates.

Leave unselected the tick box: Make a Second Copy TO:

(If you want to make a second copy of your imported files at the same time to a defferant
extenal HD then select his option.)

hown -~
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File Naming

l v' Rename Files
Template ' Geoff' default pr... g )

1. Make sure that the tick box is selected: Rename Files.

2. Selectyour personal filenaming template which you made previously.

3. Select: Extensions > Lowercase. This will ensure that all filenames are uniformally
lowercase (i.e. no CAPITAL letters).

Note example of filename format displayed at bottom of panel.

Apply During Import

Develop 'i?::ttil'l::lti None )
Metadata § Geoffs DIT identity e

eywords

1. This allows you to choose how the files are developed on ipmort after being converted to
DNG. More prosessing means a longer import time. Choose None, this time

2. This will apply your IPTC Creator and Copryright presets to your files as they are imported
automatically. Saves time and grief later.
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Keywords

Develop Settings | None

Metadata = Geoffs DIT identity

Eorope, Ireland, Dublin, Rathmines, Cathal
Brugha Barracks, military, army, |

In the keywords box add descriptive words which could be applied to the overall set ofimages
being imported.

Start with location words, such as the continent, country, city, place etc.

Continue with words which might describe to subject matter: activity, context, objects etc.

Destination Check

Into Subfolder

Organize | Into one folder
Geoff's Mac

EXTERNAL_HD
@ Download_Folder
@ Geoffs_catalog

| > [ Working_Folder

Check that the Destination Folder is the intended folder. This check will avoid endless extra
work and lostfiles at a later stage.

Go for it

Cancel Import

Slect the Import button
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Where have my files gone?

Converting to DNG and rendering previews. Finding my files.

Conversion to DNG

Convert to Digital Negative and import

Library Filter:
% (atalog gewhite_20070421_0001 D.

All Photographs 000

Quick Collection +

Current Import 2

During the Import phase your RAW files are converted to DNG and saved into the
Working_Folder. The rate of progress is visible in the Progress Bar (1).
As as each image is converted, they will appear in the Grid View (2).

Rendering Previews

Rendering Standard Previews
Lr Task completed

Navigator Library Filter:
# (Catalog —ahite_20070421_0001 D.
All Photographs 38 e =&
Quick Collection +

Previous Import 38

Previews of each file are then rendered and saved to the catalog. The rate of progress is

visible in the Progress Bar (1).
Your lastimport of images is always visible in the Catalog panel, grouped under Previous

Import.
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Where is this file now?

Open in Loupe
Open in Survey

Lock to Second Window {38+

Show in Finder
Co to Folder in Library
Go to Collection

CTRL + Click on an image in Grid View, then select Show in Finder, will reveal the individual
image file in the Finder.

Finder view

800 (] Working_Folder (@)
= : : - N
[«]>] Ho- =] O Q
¥ DEVICES ~ Name 4| Date Modified Size Kind
2 Geoff's Mac [] gewhite_20070421_0001.dng  Today, 14:41 Digital Negative file
_| EXTERN... &
¥ PLACES \-\ gewhite_20070421_0002.dng Today, 14:41 5.2 MB Digital Negative file
E Desktop
A4 Geoff Bl gewhite_20070421_0003.dng Today, 14:41 5.4MB  Digital Negative file
[ SO -

The file is now revealed in the Finder.

View of Download_Folder and Working_Folder

PPN

(] Download_Folder

R - N O ° a
¥ DEVICES Name A Date Modified Size Kind
2 Geoff's Mac™= B DSC_0301.nef 21 April 2007 14:14 6MB  Nikon Electronic Format file
| EXTERNAL... &
¥ PLACES A DSC_0302.nef 21 April 2007 14:14 5.8 MB Nikon Electronic Format file
E Desktop |
& Geoff ®eno (-] Working_Folder
0 ™ = e
(0 Documents| (g -] [ <« [» ] = O Q
/A Applications ; \G i -~
E Movies ¥ DEVICES eN N 4| Date Size. Kind
(@l Pictures 2 Geoffs M B gewhite_20070421_0001.dng Today, 14:41 5.3MB  Digital Negative file
J3 music |_| EXTERNAL... & .
& o ¥ PLACES /B gewhite_20070421_0002.dng Today, 14:41 5.2MB  Digital Negative file
@ sites A Desktop
vseArcH For || @ Geoff Bl gewhite_20070421_0003.dng  Today, 14:41 5.4MB  Digital Negative file

If you open both folders you will notice there are now two sets of identical image files. (1)
contains the original camera files, the second contains the same files only converted to DNG
Raw. The DNG files will also have any added metadata which you applied during import such
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as IPTC Creator and Copyright data.
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Adding additional Keywords after Import

You will now add additional Keywords to individual images as is appropriate to each one.
There are a number of different methods for doing this.

Grid View

Photo Metadata NI Window Help
Hide Toolbar

v Show Filter Bar

Library Filter Toggle Loupe View
Toggle Zoom View

Zoom In
Zoom Out

Increase Grid Size
Decrease Grid Size

Sort

Loupe
Compare
Survey

Co to Develop
Crop
Spot Removal
Adjustment Brush
Graduated Filter
Adjust White Balance

szxp~0 zomfal ¢

Ensure that you are in Grid View.
Enter the shortcut; "G" or go View > Grid.

Keywords from Import phase

arracks, Dublin,
ry, Rathmines

1. Selectan imaage.
2. Open the Keywording panel.
3. Note the Keywords in the panel for thatimage from import.

Entering a new Keyword

Keyword Tags Enter Keywords

army, Cathal Brugha Barracks, Dublin,
Eorope, Ireland, military, Rathmines

Clisk on below the text area where is says: Click here to add Keywords.
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Enter new Keyword

Keyword Tags Enter Keywords

architecture, army, Cathal Brugha
Barracks, Dublin, Eorope, Ireland,
military, Rathmines

Add a new word followed by a coma.
You can enter several words at a time but each keyword must be followed by a coma.
Press Enter to complete the action.

The Spray Can

a

7 Sort: Added Order

Select the Spray Can from the Toolbar at the bottom of the screen.

Enter Keywords

Keywords architecture, building, |

1. Ensure that Keywords is selected in the drop down menu.
2. Now enter your new Keywords in the text box, plus comas.

Spray Keywords

Now using the Mouse, click on any images that you want to add the new keyword(s) to.

Assigned Keywords

As you spray each image the above notice will be flashed on screen.
If you spray an image a second time, the same Keywords will be removed from the image again.
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Organising and Editing




Library View

In this lesson you will examine the main components of Lightroom in Library view.

Library View

Select Library.
if this is not visible on screen, then press the small white triangle at the top of the screen.

Library layout

®& Lightroom File Edit Library Photo Metadata View Window _Help

N3 & B 9= i+ (ZP (Charged) 4 [F Tue 10:43 Q

Left Panel - contains the Catalog, Folders and Collections.

Right Panel - contains the Histogram, Quick Develop tools, Keywording and Metadata.
Content Area - contains your images which can viewed in four different modes.

Tool Bar - this selects different views of the Content Area and gives access to some of the
editing tools.

5. Filmstrip - this allows for the selection images when notin Grid View.

on -~
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Content Area - Grid View

® Lightroom File Edit Library Photo Metadata View Window Help 3 @ E3 O = M .- (=% (Charged) 4 [F Tue10:44 Q

Library

To select Grid View:
Enter the letter G, or select the Grid icon on the Tool Bar.

Loupe View

(3
Geoff White Library

Lightroom File Edit Library Photo Metadata View Window Help N3 & D Z M .- (=F Charged) 4 [ Tue 10:45 Q

Werlsinie) Folslar

<)

0 [
] L) -
L}

To select Loupe View:
Enter the letter E, or select the Loupe View icon on the Tool Bar.
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Filmstrip

gewhite_20070421_0029.dng ~

e e e 1 5 ;
E = i ‘ 2 - : s .

This allows you to selectimages for viewing in Loupe View and Survey View.
*+ Mouse Click to select a singe image.
+ CMD + Mouse Click to select a second or subsequentimage.

Survey View

® Lightroom File Edit_Library Photo Metadata View Window _Help N3 @ 2302 m .

Geoff White Library

(= (Charged) 4 Tue 10:48 Q

Survey Mode allows for two or more images to be viewed at the same time.This useful for

editing purposes.

+  Selecttwo or more images in the Filmstrip.

. Enter the letter N, or select the Survey View icon on the Tool Bar.

+ Toremove an image from Survey View simply select the X icon on the bottom right of the
image.
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Opening and closing Panels

®& Lightroom File Edit Library Photo Metadata View Window _Help

Geoff White

N3 @ B3 o= @ .

=k (Charged) 4 [ Tue 12:30 Q.

Library

The Panels can be opened or closed to create more on screen room as follows:
« TAB key opens and closes the Left and Right Panels.
*+ TAB + SHIFT opens and closes all Panels.

* Individual Panels can be opened or closed using the small white triangles beside each
Panel.
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Quick Collection

In this lesson you will learn to make a temporary Collection of your work.

Catalog

All Photographs

Quick Collection +

Previous Import

1. Open the Catalog Panel.
2. Select All Photographs view.
3. Note the number of images in the catalog.

Add an image to Quick Collection

All Photographs 39
Quick Collection + {

Previous Import

rFolaers

Place the cursor over the top right area of an image in Grid View.
When the small circle appears, CLICK on it.

In the Quick Collection

All Photographs an gewhite_20070421_0019  DNG

Quick Collection + o o ‘ ‘
L

Previous Import
&

1. The image has now been added to the Quick Collection. Note the numeral indicating the

number of images in the collection.

2. Note also the addition of a grey circle to the image in Grid View.
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Quick Collection view

gewhite_20070421_0019 DNG

Select Quick Collection view now. You will only see those files which have been placed in the
collection.
Note, this file has not been moved from its original location on your HD. The collection is virtual.

To remove an image from Quick Collection

gewhite_20070421_0019 DNG

All Photographs 39

Quick Collection + 1

Previous Import

)

- rolaers

To remove an image, simply CLICK on the grey circle and it will be removed from Quick
Collection.

Note, the file will not be deleted from your HD. Itis simply removed from the virtual collection, it
still remains, unmodified, in the All Photographs catalog.
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Flags

You can edit your photographs using a simple flagging system.

Picks

gewhite_20070421_0017 DNG

Press the P Key to Flag an image as a Pick. Note the White Flag.

Rejects

Set as Rejected

2

MLn

Press the X Key to Flag an image as a Reject. Note the Black Flag.
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Remove the Flag

gewhite_20070421_0035 DNG

To remove a Flag, use the U Key. Note the Outline Flag.

Filter Flagged images

Select the White Flag icon to the right of Filter: on the Toolbar.
Now you should only see the Flagged images without the Unflagged images or the Rejected
images.

Filter Rejected images

- ()

Select the Black Flag icon to the right of Filter: on the Toolbar.
Now you should only see the Unflagged images without the Fagged images or the Unflagged
images.

Filter Unflagged images

EXGN

Select the Outline Flag icon (in the the centre) to the right of Filter: on the Toolbar.
Now you should only see the Unflagged images without the Flagged images or the Rejected
images.
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Which view am | in?

Unflagged Photos

-‘ |

When you choose a Filter: Flag view, you will always get an onscreen notice informing you.
Note it is possible to filter with two flags at the same time, for example you could choose to view
both the Rejected and Unflagged images together.
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Stars

A more useful way of editing is to use the Star System. This allows for a graded selection of
images rather than the more absolute Flag system.
This method is better for editing large numbers of images.

The Editing Pyramid

3 star

2 star

A\

/
gt /F/ il \ \\Neutral
4;/ /1/ Outtakes

==

£

Personal project 2

Personal project 1
All personal Home life
Family vacation

All jobs

The editing process should be seen as a "Pyramid".
The best, and rarer, material near the top, the bulk of your material further down. Rejects and
Outtakes at the bottom.

The Star Ratings

Stars Usage

(None) Neutral. Not good enough for a star, not bad enough for a
negative rating or Reject Flag

* 1 Star. Images are considered as rough cuts, to be further
considered again at a later stage. If in doubt, give it 1 star.

* % 2 Stars. Images can be considered as good enough to be
included as part of the job or project.

* % * 3 Stars. This indicates a strong image or one that could be

considered for a possible portfolio collection. 3 stars rating
should be used sparingly to have any value.

* % %k 4 Stars. Keep this rating for the best of collection, or portfolio
images. Use this rating very sparingly.
* K %k Kk 5 Stars. Rarely used rating. Keep it for a best-of-

collections/portfolios group.

View this as a guide to how you should edit your digital material.
Images which show bad technique or processing, should not be rated without a good reason.
"Ilike it", is not a good reason!.
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Setting the Rating

Set Flag 5

Set Color Label [ P
Auto Advance 2

Set Keyword = m

A
AAAN

Add Keywords... #K 1. 2.8.0.8. ¢ ;
Develop Settings > Decrease Ra\t g |

Delete Photo... €|
Remove Photo from Catalog
Delete Rejected Photos...

Increase Rating\ ]

Selectan image in Grid View.
Go: Photo > Set Rating > Choose a Rating

Rating shortcuts

Click on the dots below each image to set a Rating.

On the Toolbar, select a Star Rating.

Use the Keyboard numbers (#) to set a rating. Zero can be used to remove a rating.
SHIFT + #, this will setthe Rating and move the selection to the nextimage.

hon -~
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Filtering the edit

In this lesson you will now view your images according to their rating and apply it to the editing
process.

Unfiltered View

=L

*%k - - - *hk%k - - B e R T, *%k - - -

gewhite 20070421 0022 DNG | gewhite 20070421 _0023 gewhite_20070421_0024 ite._ X gewhite_20070421_0027

=2

*Kk - - -

This view shows all your images and their Star Rating.
Tip: Make sure that you have notleft any Flag filters active at this point.

Choose a Star Filter

in the TOOBAR, choose a Star Rating to view. Example choose 2 Stars.

Filter Method

Filter: %US(
Rating is greater than or equal to

LS

ing is less than or equal to

Rat
Rating is equal to

You can change the method of filtering your rated images as suits your editing process as
follows:

1. Selectthe Mathematical symbol to the left of the Stars in the TOOLBAR.

2. Choose the method you require.

Tip: the Rating is greater than or equal to is the most useful for most pyramid based editing.
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2 Star Filter

=5

*kokk - *k - - - Pt 0 0 0O

This will now show only images of 2 Stars or greater.

3 Star Filter

Change the filter to 3 Stars now.

This will now show only images of 3 Stars or greater.

Changing the Star Rating of an image to 2 Stars will now mean that that image will be
demoted and will now be excluded from the 3 Star View.

New 3 Star View

Note that the demoted image has been removed from the 3 Star View.
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New 2 Star View

The same image is now in the 2 Star View.
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Make a Collection

In this lesson you will learn how to make a collection in order to gather a group of images
together in. This will be separate from the Quick Collection.

New Collection

# Collections

Create Collection...
Create Smart Collection=.
= Publish Services @ Create Collection Set...

» [&] Smart Collections

Sort by Name
v Sort by Kind

1. In the Left Panel, open Collections.
2. Clickonthe +icon.
3. Choose Create Collection ...

Name the Collection

Create Collection

Name: My First CoIIectiorJ

a Set: | None
S

Collection Options

4a»

\/M Include selected photos

() Make new virtual copies o
S

( Cancel ) ( Create e
-

Give your Collection a name.

Under Set: choose None.

Tick the checkbox if you want any already selected images to go into the new collection.
Do not tick the Make new virtual copies checkbox.

Finally select Create to finish the process.

abkownN=
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Viewing the new collection

Under Collections, your new collect should be visible.
Choose it. Ifithas any images already in it already, only they will be on view.

Adding more images to your collection

Catalo¢

All Photographs 39

Quick Collection +

» = Smart Collections

B My First Collection

Return to the All Photographs view, make sure that your Collections panel is also open at the
same time.

Tip, if both panels do not stay open at the same time, then Ctrl + Click on the panel name and
deselect Solo Mode.

Drag and Drop

v (atalog gewhite_20070421_0001 DNG | gewhite_ 20070421 0002 DNG
All Photographs 39 -

Quick Collection +

Previous Import

= Smart Collectic i
= My First Collec| * * t& J' 1
. . ¥ ,

es -~

Select the images to add to the Collection. Drag your images over the Collection name, when
it changes colour Drop the files.
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Updated collection

# [E) My First Collection {3 '1

The files will have been added to the collection and the total of images in the collection revised
to reflect the addition.

Removing an image from the collection.

Develop Settings [

Remove from Collection N e
Remove Photo from Catalog® X <&
Delete Rejected Photos... k2|

To remove a selected image from a Collection, do one of the following:

1. Go Photo > Remove from Collection.

2. Go Ctrl + Click , then choose Remove from Collection.

3. Selectthe image and press Del.

Note, none of these options deletes your file, it simply removes the imgae from the collection's
membership list.
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Catalog Backup Option

Your Catalog contains copies of all your metadata, processing settings, framing and many
other items of information. Ifthe catalog is lost than most of this information is also lost. Your
Raw files are separate from the catalog and are unaffected by this. Note, they are not backed
up by this process.

Setting the Backup option

o RITT il File Edit Library Photo M
About Adobe Photoshop Lightroom 3...

Preferences...

Catalog Settings... X8,
Identity Plate S*etup...
Edit Watermarks...

Services [>
Hide Lightroom ®H |
Hide Others T #¥H
Quit Lightroom #¥Q

Go Lightroom > Catalog Settings ...

Backup settings

SN Catalog Settings
= [ General | File Handling  Metadata |
Information
. » | e—
Location: /Volumes/EXTERNAL_HD/Geoffs_catalog ( Show )

File Name: Geoffs_catalog.lrcat
Created: 22/06/2011
Last Backup: 01/07/2011 @ 15:15
Last Optimized: 01/07/2011 @ 15:15
Size: 1.12 MB

Backup

©

Back up catalog: = Once a week, when exiting Lightroom _3}

1. Select General.
2. Under Back up catalog: Select: Once a week, when exiting Lightroom.
Note, you can choose to back up daily if you prefer which would be preferable.
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Exiting Lightroom

Back Up Catalog

(-

Settings for the catalog “Geoffs_catalog" indicate it should be backed up each time it is closed.
Note: This only backs up the catalog file, not the photos referenced by it.

. ( )
Backup Folder: /Volumes/EXTERNAL_HD/Geoffs_catalog/Backups Choose...

Also: @ Test integrity before backing up

e @ Optimize catalog after backing up
A < 4

(" Skip this time\./ﬁ Backup )

When exiting Lightroom the above panel will ask you to back up.

1. Use the default Backup Folder, which will be beside your regular catalog. Normally there is

no need to set or change this.
2. Check both Tick Boxes.
3. Select Backup.

Note, these setting should onlty need to once, after that Lightroom will ask you to backup when

exiting.

Where are my Backups?

- . SRS S

DEVICES Name 4| Date Modified

| Geoff — :
eoff's Mac » || Download_Folder 23 Jun 2011 09:43

SHARED M — Ceoffs_catalog Today, 09:56

E(I:Dizktop v | Backups Today, 09:56

& Geoff SN .

Bbr > | 2011-07-01 1515 1Jul 2011 15:15

71\1 Applications Jr— .

B Movies Y 2011-07-04 0956 Today, 09:56

@i Pictures .

3 music "E Geoffs_catalog.lrcat Today, 09:56

@ ?'T “I:“ Geoffs_catalog Previews.|Irdata Today, 09:56

€9 Sites L

SEARCH FOR IE Geoffs_catalog.Ircat Today, 09:56

(L) Today

(L) Yesterday » || Working_Folder 23 Jun 2011 14:42

(L) Past Week

Backup catalogs can be found in your Catalog folder. Each Folder is dated according to when

it was made.
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Develop Mode
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Develop Module

In this lesson you will prepare the interface for developing a Raw file.

Develop mode

Select Develop on the top right of the Lightroom interface.

Left Panel

Collections

[ Portrait 2009

\ 4

= Royal Hospital Set
@ Allshots
[ Foliage

» T= Smart Collections

In the Left Panel, open both the Navigator and Collections panels.
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Right Panel

Fill Light
Blacks

Brightness

Lontrast

1. Open the Histogram interface.
2. CTRL + Click on the Basic panel
3. Select Solo Mode.

v Basic * R

v Tone Curve

v Adjustments
v Split Toning

v Detail
v Lens Corrections
v Effects

B v Camera Calibration

Show All
Hide All

Expand All
Collapse All

Choose image to process

D90918_2835.dng

.7lw1

Select a image to process from the Filmstrip at the bottom of the screen.
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Cropping the image

In this lesson you will learn to crop and straighten an image.

Crop Tool

R 418 G 424 B 385

Select the Crop Tool.

Maintaining Aspect Ratio

mom Angle

Constrain To Warp

Select the drop down menu.

Original Aspect Ratio

4x5/8x10
85x11
5x7

2x3/ 4x6

Constrain To \

Enter Custom...

1. Choose Original, this will maintain the same Height to Width ratio as the original exposure.
2. Selectthe Cropping Tool.
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Make the Crop

__(JEeWw

2011.x1337.

N O
PARKING

Drag the tool across the image to make an initial crop.

Refining the crop

Select one of the corners or sides of the crop and drag it to the required position.

Complete the crop

Select Done when you are finished cropping your image.
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Straightening an image

Crop & Straighten

" :

Constrain To Warp

Select the Straighten Tool.

Apply straightening
PARKING |
1. Click, Hold and Drag it along a section of the image which could be used as a guide, e.g..
an architectural feature.
2. Release the Mouse.
3. Theimage will rotate slightly.
4. Ifyou didn'tgetitright, simply CMD + Z, to undo the change, or take a step backwards in

the History Panel.

Note: the cropping of an image in LR does not destroy any image data, your original image
data is unaffected.

Reseting an image

You can return an image to its original full frame by Selecting: Reset.
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Finding cropped images

rPhoto has been cropped

Cropped images a can be identified in the Filmstrip by the small icon on the bottom right of a
cropped image.

Lightroom v5 - 65



White Balance

In this lesson you will set the White Balance (WB). This sometimes referred to as the White
Point or the Colour Temperature.

Histogram and Basic Panels

R 721 G 706 B 70.6

Black & White

As Shot

Auto

Open the Histogram and Basic panels.

White Balance tool

Color Black & White

Custom

Select the White Balance tool and drag it over to the image you are working on.

Lightroom v5 - 66



Grey Card Method

Pick a target neutral:

Click the end of the tool on the Grey card.
Note the proportions of Red, Green and Blue in the grey area.
Note, do not use a White or Black area of the card.

No Grey Card available?

Pick a target neutral:

|
|

||

If the image was shot without a grey card, then try to find an area in the photograph which you
judge should probably be a neutral grey.
Avoid areas which look like they should be white or Black.
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The final setting

Color Black & White

Custom @

1. The WB Tool will now set the White Balance to a number, known as the Colour
Temperature.

2. This can be further refined by using the Tint slider. Moving it to the left makes the image
colder (green), to the right warmer (magenta).

3. Return the WB Tool to its position in the panel when you are finished with it.
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Setting the Histogram

In this lesson you will set the White and Black points of the Histogram. This refers to the spread
of Tones across your image.

Note: the initial image, a RAW file, will look flat and dull before processing. This is normal.

Histogram sliders

Auto

1. The limit of the lightest tones is controlled by the Whites Slider.
2. The limit of the darkest tones is controlled by the Blacks Slider.
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Initial tonal range

The initial range of tones is restricted and needs to be expanded by resetting the Histogram.

Set the Whites

1. Hold down OPT [Alt} key and increase the Whites slider to about +85.
2. White areas (see above image) represent area of the image which will be clipped in the

whites, i.e. no detail.
3. Now, hold down OPT key again and decrease the Exposure slider to about +45. This
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should be to the point where all white areas have just disappeared.

Before and After Views

Before & After: =0 el r::_‘

Select the Before & After Views button to view your image's progress.

Different Before and After views

Using the same Before & After Views button, cycle through different views until you have the
image as below

Update the Before and After views

|

| | Before & After: =

Select the button with the left pointing arrow. This will now update the Before view with the

After view,
Note: both images will now appear the same, but you will only be making changes to the After

view.
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Set the Blacks

Now repeat the same methodology using the Blacks slider.

1. Hold down OPT key and increase the Blacks slider to about -25

2. Black areas (see above image) represent area of the image which will be clipped in the
Blacks, i.e. no detail, therefore pure black.

3. Now, hold down OPT key again and decrease the Blacks slider to about-12. This should
be to the point where there is still some small amount of black remaining.

Compare the Before and After Black areas

Enlarge the black areas and note that the Blacks are now darker but also lacking in detail.
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Fine tuning the Histogram

In this lesson you will refine the tonality in the shadow areas.

Update the Before and After views

| Before & After:

Now update the Before view with the After view again.

Shadows

Auto

Now slide the Shadows slider right to about +60
This will lighten the tonality in the shadow area but leave the blacks unaffected.
Tip: watch the Histogram as you do this.
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Compare the Black again

Note how the detail in the black scarfis now visible.

Highlights

Highlights slider works lighteninging or darkening the lighter tones in the image without

efecting the lightest tones.
Applying a small amount, + 20, with the Highlights slider slightly lightens the image.
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Highlights effect

8
JAN
e

48 Befc;re
After

Notice how the skin tone has been splightly lightened.
Highlights can also be to darken liht areas of an image in order to restore detail.
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Curves

In this lesson you will apply a Curve in order to give the image a visual dynamic.

Update the Before and After views

| | Before & After: =1 el

Now update the Before view with the After view again.

Tone Curve

Highlights
Lights
Darks

Linear

Now open the Tone Curve panel.
1. Curve panel, note the faint representation of the Histogram behind the Curve.

2. Curve sliders.
3. Each slider corresponds to one Region ( or Quadrant) of the Curve, e.g. Highlights slider

controls the Curve's lightest tones.
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Curve principle

lighter

darker

=24
—h

Linear /

1. Moving the sliders to the right will lighten tones in that Region and move the Curve

upwards.
2. Moving the sliders to the left will darken tones in that Region and move the Curve

downwards.
Tip: as a general rule you are trying to achieve a slightly "S" shaped curve for best overall tonal

distribution.

Apply the Curve

Linear /

Now apply the following setting to the image:
1. Highlights +25
2. Lights +10
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3. Darks -3
4. Shadows -9

Settings 1 & 2 will lighten the lighter tones giving a greater tonal separation.

Settings 3 & 4 will darken the darker areas slightly but will maintain the tonal separation.
Note: Mid-tone contrast will also have been increased slightly. Contrast refers to the rate of
tonal change.

Compare the Before and After views

Note the changes in the overall tonality.

Lightroom v5 - 78



Compare the highlight and shadow details

Note how the Curve influences the final output of the image, Despite the full range of tones in
the Before view, it is the redistribution of the tones in the After view which adds a visual
dynamic to the image.
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Monochrome Images

In this lesson you will make a monochrome (Black & White) image

Open the colour image to be converted

Find the White Point

Pick a target neutral:

Use the White Balance Selector to find the White point.
In this case, using the shadow area of the white cat..
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Black and White

Treatment : Color Black

As Shot

Now Select Black & White.

Before and After Views

Before & After: =0

select the Before and After views.

Colour and Black and White views

You now have both the colour and B/W views of your image on screen. As you make
modifications, only the After image will change.
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Levels

i 744 G 744 B 744

Color Black & White

Custom

P

Auto

+ Selectthe Levels tools and apply as required.
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R 744 G 744 B 744

Color Black & White

Custom

P

Auto

Curves

+ Selectthe Curves tools and apply as required.
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Colour/tone modification

Black & White Mix

A
B
s
e

-

P’

Auto

Now open the Black & White Mix tools.

Black and White Mix

1. Selectthe Target Adjustment tool.
2. Place the crosshairs of the tool over a "coloured" area.
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modifying tones based upon original colour

1. Hold the Mouse down and move the it upwards to lighten the tone for the corresponding

colour, e.g.. Reds are modified to become a lighter greys.
2. Hold the Mouse down and move the it downwards to darken the tone for the corresponding

colour, e.g.. Greens are modified to become a darker greys.

Complete the modification

Select Done.

View finished image

Now view your final image.
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Exporting Files

Lightroom v5 - 86



Create an Export Folder

In this lesson you will make a new Folder for exported image files.

External Drive

——————

®eno [ ]Red_Cyan (@)
-] («[>] EA=[ml=] (=] O (= Q ‘
Action Back View Path : Get Info Quick Look Search

DEVICES

L Geoi's wiac — — —

« LaCie 250 Gb — ’

SHAKRED

M epson987fos = geoff_catalogue Holding Folder Working Folder

=] EPSON98B7FOS (Epson ...

Navigate to your External drive and find your Holding and Working Folders.

Create New Folder

8000 ”
4 |
B (<[> mm] [=-]
Newolder Q  path

. Open

1. Selectthe TASK Button.
2. Select NEW FOLDER from the menu

Name it

enNnO _ ™| Red_CyanrA

(g5-] [«]>] H=zom (=] ‘ o e

Action Back View Path H Get Info Quick Look Search

DEVICES
! Geoff's Mac
« LaCie 250 Gb —

SHARED

M) epson987fos = geoff_catalogue Holding Folder Working Folder  @IFLIELE 10D
|| EPSON9S87FOS (Epson ...

Name the folder Lightroom Exports.
Ensure that this folder is in the same location as the Holding and Working Folders, and not

inside one of them.
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Export to email

In this tutorial you will learn to export a Jpeg file to your Export folder for emailing.

File menu

® Lightroom [EM Edit Develop Photo Settings Tools
- YeYe) New Catalog...
Open Catalog... +30
Open Recent 8
Optimize Catalog...
Import Photos and Video... ol |()

Import from Another Catalog... ). b
Tethered Capture 2 2
U

Auto Import

Export with Previous
Export with Preset >
Export as Catalog...

1. Selectthe files you wish to email

2. Then go File > Export...

Email (Hard Brive} setting 1

WOOLO Export One File
Export To: | Hard Drive s
v Lightroom Presets v vt Location
Burn Full-Sized JPECs 1 i
Export to DNG \/Export To: | Specific folder ! C]

ety

For Email (Hard Drive)
> NI e
¥ User Presets

()

Folder: /Volumes/LaCie 250 Gb/Demo...aterial/Download/export_folder™ ( Choose... )

_l Put in Subfolder:

(1 Add tn This Catalon Add to Stacl Relow O

Existing Files: | Ask what to do

¥ File Naming

1. Choose Email (Hard Drive).
2. SetExport to: select Specify Folder. This should be your Export Folder.
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Email (Hard Brive} settings 2

¥ File Naming 'Y
o [C) Rename To: Filenan
Example: gewhite_20100819_4977.jpg Extensions: | Lowercase, Q
7} Vidan ':'ﬁ\ﬁdeo

7 File Settings

e, Image Format: | JPEG
Pty

Color Space: | sRGB

Quality: e sy E |

() Limit File Size To: 10 K

A

@ 3

Add Remove v

€ Plug-in Manager... ) Cancel \_ Export )

1. Do not selectthe Rename to box, so the exported file will retain the same name as the
original.
2 . Selectlmage type: Jpeg

Select Color Space: sRGB

Select Quality: 50

Email (Hard Brive} settings 3

Export One File

Export To: | Hard Drive >
Lightroom Presets o/ VUL
Burn Full-Sized JPEGs ™ ¥ Resize to Fit: [ Width & Height 4] [ Don't Enlarge
Export to DNG — — — i
. W: 640 H: 640 pixels + | Resolution: 72 pixels perinch 3!
For Email R —— ———

For Email (Hard Drive)
Nik Software
User Presets e 2’ Sharpen For: | Screen 1 Amount: | Standard
4

¥ Uutput Sharpening

N o maa_ o

1. Setlmage Size as follows:

Select the Tick Box.

Choose Resize to fit: Height x Width

Enter W: 640 H 640 pixels Resolution 72 pixels per inch.

2. Setlmage Sharpening as follows:
Select the Tick Box..
Choose Sharpen for: Screen. Amount : Standard
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Email (Hard Brive} settings 4

( Plug-in Manager... )

o ¥ Melaudia
A

(2]

p—

Add Ren e
N

Copyright & Contact Info Only

v/ Remove Location Inf

Write Keywo L
V¥ Watermarking

() watermark: simple Copyright Watermark
V¥ Post-Processing

After Export: | Show in Finder

Application: (

1. Set Metadata as follows:
Choose Contact and Copyright Info Only.

2. Set Watermarking as follows:
Do nottick box unless you want your name across the image.

3 Set Post-Processing as follows:
Choose After export: Show in Finder.

4. Select Export.. The exportted file should now be in your Expor folder.
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Making a single page layout and Exporting it as a Jpeg file

In this lesson you will make up a 5 x 3 cell page and export the layout page as a single Jpeg
file.

Print Module

Library | Develop | Map | Book | Slideshowl| Print |JWeb

Select the Print Module

Page setup

Page Setup... Print Settings...

Collections / Lexic

Select Page Setup ..

Designate Page Size

Page Setup

Settings: | Page Attributes v

o
Format For: | Any Printer

e Paper Size: | A4 v
a—

8.26 bv 11.69 inches

ﬂ

Orientation: 'i '93

g Scale: 100 %

@ ( Cancel ) ( OK )

1. SetFormat For: Any Printer.

2. SetPaper Size: A4.

3. Set Orientation to Portrait Orientation.
When complete, Select OK.
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Guides

v Show Guides

Rulers

Page Bleed

Margins and Gutters
v Image Cells

Dimensions

In the Guides panel, Select the Show Guides Box and the Image Cells Box only.

Image Settings

Zoom to Fill
Rotate to Fit
Repeat One Photo per Page

Ensure that none of the three boxes are selected in this panel.
Optional: If you want to put a fine black line around each image, then Tick the Stroke Border
box.

Layout and Margins

Ruler Units : Centimeters

Mar :ﬁlil'l S

Ensure that Centimeters is selected for Ruler Units.

Enter Left: 2.00
Enter Right: 2.99
Enter Top: 1.00
Enter Bottom: 2.50
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Page Grid

Under the Paper Grid section:
Enter Rows: 5
Enter Columns: 3

Cell Size

Height
width

v Keep Square

Tick the Keep Square box
Enter Height: 4.77
Enter Width: 4.77

Cell Spacing

Horizontal

Enter Vertical: 0.71
Enter Horizontal: 1.33

Note: The above settings are indicative and will vary.
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Identity Plate

Page Background Color

v’ Identity Plate 0

1. Select: Identity Plate
2. SelectOverride Color
3. SetScale 30%

Title

1. Select Photo Info
2. Select Title from the menu of metadata headings
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Page View

Drag the Identity Plate down to the bottom of the page.

Your page layout should look similar to the above.
Make sure the your Identity Plate does not disappear under the bottom margin. Reduce the

text size if necessary.
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Select Images

| gewhite_20110928_6566

> Pattern

, Copyrighted
Geoff White

In Collections select to be used and ensure that they are in the correct order to be printed.
Ensure that the images have text entered under the Title heading in the IPTC metadata.
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Image and Text on the Page

p—

Square Re ctangle

Thangle

Refection

Pattern

Desatumd

GEOFF WHITE

Sawrated

In Print mode, check the order and positioning of the images on the page before preceding.

JPEG File

Printer
Printto : v JPEGFile

Draft Mode Printing

Open Print Job
Select Print to: JPEG File
Leave Draft Mode Printing unselected
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File Settings

File Resolution 240

v’ Print Sharpening : Standard

Media Type Glossy

JPEG Quality

Custom File Dimensions

Set File resolution: 240 ppi

Set Print Sharpening: Standard

Set Media Type: Glossy

Set: Jpeg Quality: 100

Leave Custom File Dimensions unselected.

Colour Management

Color Management

Profile : Adobe RGB
Intent Perceptual Relative

Print Adjustment

Set Color Management: Adobe RGB
Set Intent: Perceptual
Leave Print Adjustments unselected.

Print to File

Print to File...

Select Print to File . ..
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Save File

OO Save File

Save As: gewhite_20121023_0001.jpg

(4 »

A’

— ~ 7
[SE »Eval [ exports
N’

¥ DEVICES hiame
| Geoff's ...
& Geoff W...
Kl iDisk
@ [aCi... &

¥ SHARED
LEJ epson9s...
= EPSONS...

¥ PLACES
(] Dropbox .
A Desktop v

o

Date Modified w

e A
C Cancel )

 New Falder )
[ New Folder ) GSM‘)
7
1. Navigate to your Exports Folder
2. Name your new file, using the correct filenaming format
3. Press Save
Verify the file
8eno (] exports
()] H:=k = @ B 0
Action Dropbox Back View ~ Path - Connect iDisk GetInfo |
£l ibisk asg
« LaCie 250 Gb a gg:
’ SHARED §§=
[!J epson987f05
B EPSON987FO5 (Epson ... gewhite_20121023_
= 0001.jpg
" PLACES

Using the Finder, navigate to your Export Folder
Check that your saved file is correctly located there.
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Exporting a JPEG file

In this lesson you will learn how to set up Lightroom to export a Jpeg image to a set required
dimension

Select files

a Library Photo Metadata View Window Help

New watalog...
Open Catalog... %0

Open Recent >

Optimize Catalog...

Import Photos... |
Import from Catalog...

Tethered Capture >
Auto Import >

Export... N

Export with Previous
Export with Preset
Export as Catalog...

1. Selectthe files for export.
2. Then go File > Export...

Export Panel

K00, Export 4 Files
Export To: | Hard Drive }-64
Preset o L
¥ Lightroom Presets | » Export Location /Nolumes/LaCie 250 Gb/Demo Materials/Lightroom_4_material/viveza/export ]
Burn Full-Sized JPEGs
Export to DNG » File Naming gewhite_20121107_7971.jpg
For Email » Video
For Email (Hard Drive) = =
» Nik Software | » File Settings JPEG (60%) / AdobeRGB (1998) l
¥ User Presets » Image Sizing 240 ppi/ Resize Short Edge to8in
» Output Sharpening Sharpening Off
| » Metadata All, Remove Location Info l
» Watermarking No watermark

¥V Post-Processing

After Export: | Show in Finder iﬂ
Application: Choose an application.. ¥ ( Choose...
Add Remove
Plug-in Manager... ( Cancel ) E—EAW'P’

4

Select Export to: Hard Drive
Export settings are made on the right hand panels.
Settings can be saved as Presets for future use on the left by selecting the Add button.
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Export Location

¥V Export Location

Export To: | Specific folder ﬂ g
Folder: /Volumes/LaCie 250 Gb/Demo...aterial/Downlcad/export_folder™ ("Choose... )
(7] Put in Subfolder: e
(7] Add to This Catalog s N | Add to Stacl Below Or
Existing Files: | Ask what to do ﬂ \e

1. Choose the destination folder on your external drive,: Lightroom Exports.
2. Leave the two boxes unselected.
3. Choose: Existing files: Ask what to do.

File Naming

¥ File Naming

(7] Rename To: Filename
Custom Text Start Number
Example: gewhite_20111026_6760.jpg Extensions: | Lowercase -:]

File names should remain the same as the original file, so do not select the box.

File Settings

v V¥ File Settings o 0
- N4 N2

Image Format: | JPEG ﬂ Quality: o O 60
e Color Space: | AdobeRGB (1998) i)' O Limit File Size To: 100 o

Select Format : JPEG.

Set Quality: 60.

Select Color Space: AdobeRGB (1998).
Leave the remaining boxes unselected.

hown -~

Image Size

¥ Image Sizing
\
S —
M Resize to Fit: | Short Edge _3] (] Don't Enlarge

o 8.000 in %] Resolution: 240 pixels per inch |5 ] o

-

1. Selectthe box and then Short Edge.
2. Input8.00 and choose Inches.
3. Inputthe Resolution:: 240, and choose Pixels per inch.
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Sharpening, Metadata and Watermarking

’ ¥ Output Sharpening ‘

(O] Sharpen For: | Screen = Amount: | Standard

’ ¥V Metadata ‘

| All v

«

[C) Remove Location Info

@ Write Keywords as Lightroom Hierarchy

¥ Watermarking "~

[C) watermark: Simple Copyright Watermark

Leave the remaining boxes unselected, except Write Keywords as Lightroom Hierarchy.

Post-Processing
} V¥ Post-Processing ‘m
After Export: | Show in Finder ?}
A
Application: Choose an application... ¥ [ Choose...

y !

( Cancel ) ( Export )

Select: After Export: Show in Finder.

You can now save your settings as an Export Preset at this stage by selecting the Add button
on the Preset panel (left).

To export your files now, select Export.

Check in Finder

eno [] Lightroom Exports (@)
= O Q
Action Back View Path i Get Info Quick Look Search

DEVICES Name Date Modified Size 4| Kind

! Geoff's Mac B gewhite_20111026_6760.jpg Today, 09:43 401 KB JPEG image

e E e a B gewhite_20111026_6761.jpg  Today, 09:43  414KB  JPEG image

B gewhite_20111026_6763.jpg Today, 09:45 537 KB JPEG image
R B gewhite_20111026_6764.jpg  Today, 09:44 684 KB  JPEG image

»

B epson9s7fos

Check your exported files in your Lightroom Exports Folder.
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Exporting a Catalog

In this lesson you will learn how to export a catalogue plus copies of its image files.
Very important: if you only need to export the catalog with preview images, but without the
original image files, please note item 3 in the Export Dialogue step below.

Export folder

geoff_catalogue Holding Folder Working Folder Lightroom Exports

Ensure that you have an Lightroom Export folder beside your Holding and Working Folders. If
you do not have one, see the earlier tutorial titted: Create an Export Folder

Select images to export

gewhite_20081001_00016 DNG gewhite_20081001_0001-7 DNG | gewhite_20081001_0001-13 D... | gewhite_20081001_0001-8 DNG

=4

=4 =4 =l

Select the images which are to be included in the exported catalog. If necessary, place them in
a separate Collection for convenience.
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File > Export as Catalog

JIW Edit Library Photo Metadata Vi
New Catalog...
Open Catalog... 30
Open Recent =
Optimize Catalog...
Import Photos... 3l |
Import from Catalog...
Tethered Capture > |
Auto Import 4
Export... {38E
Export with Previous X {r3E
Export with Preset =

Export as Catalog... N

Plug-in Manager...
Plug-in Extras

Go File > Export as Catalog . ..

136,
>

Export dialogue

OO Export as Catalog

Save As: [geoff_export_project_zo 101201| 6]
& 4

PIENE™ 10L[j Lightroom Exports

®)a

DEVICES Name

. Geoff's ...
& Geoff W...

< LaCi... &

SHARED
(9] epsongs...
=] EPSONS...

PLACES S
A Desktop

o

M Export negative files
@ Include available previews

4| Date Modified

Exporting a catalog with 4 photos

E] Export selected photos only

[ New Folder )

1. Navigate to your Lightroom Export folder.

( cancel ) ( Export Catalog

2. Name your new catalog using your name, project brief and date of submission.
3. Ensure that all three boxes are selected if you want to export copies of your image files
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with your catalog. Otherwise, do not select the box Export negative files, thus only the
catalog and image previews will be exported.
4. Select: Export Catalog.

The exported catalog

(] Lightroom Exports

0O (=

Get Info Quick Look

geoff_export_proj
ect_20101201

Lightroom will now make a new catalog containing only the selected images plus copies of the
image files.
These will be placed in a new folder within the Lightroom Exports folder.

The exported catalog and Working folder

(] geoff_export_project_20101201

L fom ] [=-] O

W Path Get Info Quick Look

E 'E

geoff_export_proj geoff_export_proj Working Folder
ect_201...s.Irdata ect_201...01.lrcat

Use the Finder to check the catalog is correctly saved in the right location. You should see two
Lightroom catalog files plus a new copy of your Working Folder.

Open the new catalog in Lightroom to ensure thatitis as you intended it. You can now Quit
Lightroom if you are satisfied with the new catalog.
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Check the images

(] Working Folder

||]]]l|lll|] [——_v] 0 /Q—

ew ~ Path Get Info Quick Look Se

gewhite_2008100  gewhite_2008100  gewhite_2008100  gewhite_2008100
1_0001-6.dng 1_0001-7.dng 1_0001-8.dng 1_0001-13.dng

Open the new Working Folder in the Finder and check that the images are present and
correct. Use Bridge to check the images. This step is notrelevant if you have not exported

your image files with your catalog.

Burn Folder

m Edit View Go Window Help

”

New Finder Window #N
New Folder {#N
New Smart Folder T #N
Open #0
Open With

I |
Close Window #BW

Open a New Burn Folder in the Local Share, or on your Desktop if working on your own
machine.

Select files

L]

0o (2] Burn Folder.fpbf (@)
(#-] (<]>] -—Irmlu-"] = O N
Action Back Path i Get Info Quick Look
DEVICES Burn Folder. fpbf m
| Geoff's Mac o‘
@ LaCie 250 Gb
l@ . E—
SHARED
(B epsongs7fos .“
= EPSON9B7FOS (Epson .. A A FI—
PLACES geoff_export_project  geoff_export_project Working Folder
A Desktop 2 _201012.. ews.Irdata _20101201.Ircat
&~ = b 4
3 items, minimum disc size: 23.8 MB @ [CIE—n——) 4

1. Drag the catalog files and the Working Folder into the Burn Folder.
2. Check the size of the export. Inserta new CD or DVD into the Mac depending on the total

size of the export.
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3. Select Burn.

Burn dialogue

Are you sure you want to burn the contents of “Burn
Folder.fpbf” to a disc?

D You can use this disc on any Mac or Windows computer. To eject the
disc without burning it, click Eject.

\0,/ Disc Name: Geoff_Project_Brief_ZOl11201| ]

Burn Speed: ' Maximum Possible (24x) @

( Eject ) (Cancel) ( Burn\f |

Se——

1. Name the new disc.
2. SelectBurn.

Burn

K00 Burn

Burning disc: “Geoff_Project_Brief_20111201"

0 T,

‘ ST T T T T """ WM4NW4WMN4NN"

State: Writing track 1

The software should now burn the CD/DVD and Verify it.

Check the disc
N.Yole) (=) Geoff_Project_Brief 20111201 (@)
() (<[] HAs»= = O Q
Action  Back View ~ Path Get Info  Quick Look Search
¥ DEVICES M
| Geoff's Mac m\\
@ LaCie 250 Gb A T
d
SHARED " =
L!I epson987f05 geoff_export_project  geoff_export_project Working Folder
=] EPSON987FOS (Epson ... _201012...ews.Irdata _20101201.Ircat

Using the Finder check the new disc to ensure that both the catalog files and image files are
present.
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Troubleshooting

“oara |8 -
E
A A n
Gun“_export_project geoff_export_project Working Folder
_201012...ews.Irdata _20101201.Ircat

If your files on the disc show small arrows as above, then your disc did not burn the files only a
series of Short Cuticons which contain no data. You will need to redo the burning process.

Burning discs on the TB network is best done with all material copied into the Local Share as
working from your external drive and the network is generally too slow.

If you are working on your laptop or PC then place the files into a temporary folder on your
Desktop.

NB. You will notbe able to open your Catalog directly from your CD/DVD, and you will get an
error message. This is because Lightroom expects to be able to write to the drive where the
Catalog is but can't since itis now on a locked CD/DVD. This is normal so do not worry.

Lightroom v5 - 108



	Lightroom v5
	Table of Contents
	Getting Set Up
	Setting up folders on your external hard drive
	Select your External HD
	Make first new folder
	Your catalogue and Images folder
	Folder
	Label
	Red Label
	Download Folder
	Working Folder
	Folder Structure

	Make new catalog
	Opening Lightroom from the Dock
	Opening Lightroom from the Applications Folder
	New Catalog
	Enter catalog location and name
	Lightroom opens
	The Finder
	Catalog folder contents

	Setting preferences
	Open Preferences
	General references
	Presets Preferences
	Export Editing Preferences
	File Handling Preferences
	Close Preferences

	Setting your IPTC Identity
	Edit Metadata Presets ..
	Metadata Presets Panel
	Complete the form
	Save the New preset
	Name it
	Complete this step

	Setting your Copyright
	IPTC Copyright
	Save changes
	Complete this step

	Making your Identity Plate
	Preferences
	Enter name
	Save as ...
	Name the identity plate!
	New identity plate


	Importing Raw Files
	Transfering files to Download folder
	Card reader
	Download Folder
	Select RAW files to transfer
	Drag and Drop

	Setting up File Naming template
	Import Photos . . .
	File Renaming
	Edit template
	Template Editor
	Add date information
	Add the File Number
	Save the preset
	Name the preset
	Complete it

	Importing - source and destination
	Import Photos . . .
	Source
	Destination
	Convert RAW files to DNG (Digital Negative Raw files)
	Selecting files to Import
	File Handling
	File Naming
	Apply During Import
	Keywords
	Destination Check
	Go for it

	Where have my files gone?
	Conversion to DNG
	Rendering Previews
	Where is this file now?
	Finder view
	View of Download_Folder and Working_Folder

	Adding additional Keywords after  Import
	Grid View
	Keywords from Import phase
	Entering a new Keyword
	Enter new Keyword
	The Spray Can
	Enter Keywords
	Spray Keywords
	Assigned Keywords


	Organising and Editing
	Library View
	Library View
	Library layout
	Content Area - Grid View
	Loupe View
	Filmstrip
	Survey View
	Opening and closing Panels

	Quick Collection
	Catalog
	Add an image to Quick Collection
	In the Quick Collection
	Quick Collection view
	To remove an image from Quick Collection

	Flags
	Picks
	Rejects
	Remove the Flag
	Filter Flagged images
	Filter Rejected images
	Filter Unflagged images
	Which view am I in?

	Stars
	The Editing Pyramid
	The Star Ratings
	Setting the Rating
	Rating shortcuts

	Filtering the edit
	Unfiltered View
	Choose a Star Filter
	Filter Method
	2 Star Filter
	3 Star Filter
	New 3 Star View
	New 2 Star View

	Make a Collection
	New Collection
	Name the Collection
	Viewing the new collection
	Adding more images to your collection
	Drag and Drop
	Updated collection
	Removing an image from the collection.

	Catalog Backup Option
	Setting the Backup option
	Backup settings
	Exiting Lightroom
	Where are my Backups?


	Develop Mode
	Develop Module
	Develop mode
	Left Panel
	Right Panel
	Choose image to process

	Cropping the image
	Crop Tool
	Maintaining Aspect Ratio
	Original Aspect Ratio
	Make the Crop
	Refining the crop
	Complete the crop
	Straightening an image
	Apply straightening
	Reseting an image
	Finding cropped images

	White Balance
	Histogram and Basic Panels
	White Balance tool
	Grey Card Method
	No Grey Card available?
	The final setting

	Setting the Histogram
	Histogram sliders
	Initial tonal range
	Set the Whites
	Before and After Views
	Different Before and After views
	Update the Before and After views
	Set the Blacks
	Compare the Before and After Black areas

	Fine tuning the Histogram
	Update the Before and After views
	Shadows
	Compare the Black again
	Highlights
	Highlights effect

	Curves
	Update the Before and After views
	Tone Curve
	Curve principle
	Apply the Curve
	Compare the Before and After views
	Compare the highlight and shadow details

	Monochrome Images
	Open the colour image to be converted
	Find the White Point
	Black and White
	Before and After Views
	Colour and Black and White views
	Levels
	Curves
	Colour/tone modification
	Black and White Mix
	modifying tones based upon original colour
	Complete the modification
	View finished image


	Exporting Files
	Create an Export Folder
	External Drive
	Create New Folder
	Name it

	Export to email
	File menu
	Email (Hard Brive} setting 1
	Email (Hard Brive} settings 2
	Email (Hard Brive} settings 3
	Email (Hard Brive} settings 4

	Making a single page layout and Exporting it as a Jpeg file
	Print Module
	Page setup
	Designate Page Size
	Guides
	Image Settings
	Layout and Margins
	 Page Grid
	Cell Size
	Cell Spacing
	Identity Plate
	Title
	Page View
	Select Images
	Image and Text on the Page
	JPEG File
	File Settings
	Colour Management
	Print to File
	Save File
	Verify the file

	Exporting a JPEG file
	Select files
	Export Panel
	Export Location
	File Naming
	File Settings
	Image Size
	Sharpening, Metadata and Watermarking
	Post-Processing
	Check in Finder

	Exporting a Catalog
	Export folder
	Select images to export
	File > Export as Catalog
	Export dialogue
	The exported catalog
	The exported catalog and Working folder
	Check the images
	Burn Folder
	Select files
	Burn dialogue
	Burn
	Check the disc
	Troubleshooting



